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Overview
Supervisor is a powerful, user-friendly geostatistical suite that optimises resource
estimation and enhances productivity for mineral resource geologists. Trusted by
leading mining and consultancy companies worldwide, it offers advanced tools like
variography, conditional simulation, and model validation, ensuring that mineral
resources are calculated with maximum accuracy. Built by geologists for
geologists, Supervisor streamlines complex geological tasks, saving valuable time
and enabling efficient decision-making. Its intuitive interface and clearly presented
data make it easy to model orebody characteristics from raw sample data,
providing everything needed to optimise resource estimates and deliver high-
quality, robust results.

Further Information
This document includes cumulative release notes for Supervisor.

Release notes for other versions of Supervisor are available via the Support Portal
https://dataminesoftware.com/support/.
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Supervisor 9.2.1 Hot Fix
Release Notes (October 2025)

Defect Fixes
l It was not possible to import a numeric column from a DM/DMX file as a
string. You had to force importing as a numeric (double, int64, ...).

l An errorwas popped up when going to the Point/Block Data Loaded
Options, in the Rotate Data in 2D tab. The error could be safely ignored
though.

l The addition of a Threshold in a Log Probability plot returned an error. The
component now works as before.

l InModel Validation:
l Histogram legend now displays correctly the data and the mean used.
l GTC legend is now linked with its property page.

l Loading a project with Global Topcutwithmissing data could send errors
and it could even automatically remove the Global Topcut components from
the datatree.

l Sometimes, an error appeared during the reload the Conditional Simulation
default component when launching Supervisor.

l Since the 9.2 version, components in the tree were not coloured anymore if
there were attached errors or warnings.

l Saved project with Conditional Simulation component will not throw an error
about missing result files when updating Optimum DigLine or Grade Proba
Cutoff components.

l Supervisor no longer crashes when theMineTrust Connector contains
invalid server settings. Minor improvements were also made to project
synchronization handling.

l The installer incorrectly reinstalled .NET 9 Runtime even when it was already
present. The detection logic has been fixed, and new CLI options were added
to skip runtime installations if needed.
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Supervisor 9.2 Release Notes
(October 2025)

New features & Improvements
l Visualization improvements:

l Graphics in Supervisor are now dynamically linked, improving visual
feedback and identification of outliers. When you highlight data in one
component, the same data is automatically highlighted across all other
components. Selections can be made in:

l Histograms,
l Scatter plots,
l Probability plots,
l Boxplots,
l Hexbin plots,
l Correlation matrix,
l Cross validation,
l 3D views.

Selected samples are displayed consistently across graphics using a
contrasting highlight color (the opposite color using the RGB code).
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Selection options:
l Left click on data: Create a new selection by clicking individual
samples or drawing a rectangle.

l SHIFT + Left click on data: Add selected samples to the current
selection.

l CTRL+ Left click on data: Toggle the selection status of the
selected samples. If a sample was already selected, it is removed
from the current selection. Conversely, if a sample was not
selected, it is added to the current selection.

l Left click outside of the data: Remove selected samples from the
current selection.

3D view selection modes (available from the 3D menubar):
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l Select Above / Below / Left / Right: Select samples on one side of
a line. Just keep the left button of your mouse pressed and move
your cursor to draw the line. Do another click to end up the line
display and finally highlight the samples which are above / below /
left / right to the segment.

l Select Rectangle: Select samples with a rectangle. Just keep the
left button of your mouse pressed and move your cursor to draw
the rectangle. Do another click to end up the rectangle display and
finally highlight the samples which lie inside the rectangular
selection.

l Select Inside / Outside Polygon: Select samples inside / outside a
digitalized area. Just do a first click on the 3D view to start to draw
your polygon and move your cursor to continue the display. Do
another click to end up the polygon display and finally select the
samples which lie inside /outside the polygon.

These 3D selection modes are compatible with the SHIFT / CTRL
shortcuts.
Finally, a new right-click menu option allows you to apply the current
selection (or its inverse) as a filter to your dataset.

l Grade Tonnage curves from Conditional and Multivariate Simulations
can now be overlaidwhen using the option with multiple selections.

l A legend tab is now available in the properties of the following
components:

l Histogram of the cross validation,
l Hexbin plot,
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l Trend plot,
l Model validation (trend plots, histogram, probability plot and QQ
plot).

l The ellipsoid associated with a continuity model is now locked to the
X/Y/Z axes in the 3D view, preventing it from disappearing or getting
out of sight when rotating or panning the view. In addition, the ellipsoid
can now be resized through its properties: by default, its size is based
on the variogram ranges, but it can be modified either proportionally to
the original dimensions or independently along the X, Y, and Z directions.
The ellipsoid is also now visible from the Backtransformation
component.

l Data exchanges:
l Supervisor now supports Datamine’s DMX format for import, in
addition to the .dm extension. With enhanced compression, full Unicode
compatibility, and support for up to 2048 columns, this modern format is
built to handle today’s complex datasets, making your workflow more
robust and scalable.
The performance of the dm import has been optimized.

l MineTrust is now integrated into Supervisor to allow sharing and
synchronization of projects. With Supervisor 9.2, you can:

l Open MineTrust projects that have been shared.
l Save your current project as a package in MineTrust, provided
the connection is available.

When creating a package, you can choose whether to share it with other
users and whether to include the results folder. This makes it easier to
distribute projects and outputs within your team.
The figures below illustrate the dialogs for opening a MineTrust project
and synchronizing a project.
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l A new right-click option allows you to export all variograms at once.
l Exports the back-transformed variogram when data is
transformed, or the raw Continuity Model variogram otherwise.

l Results are combined into a single table, equivalent to exporting
variograms individually.

Supervisor 9.2 Release Notes (October 2025) 10



l Software architecture & Error tracking:
l Demo projects have been added to the software installer to help users
get started more easily. These demos include two sample projects that
correspond to the tutorials Global Topcut Analysis and Variography and
Conditional Simulation. They can be accessed from a new Demo
Projects section on the home page when the application starts, or from
the Open / Open Demo Project menu.
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l The underlying platform has been upgraded to .NET 9, ensuring ongoing
Microsoft support, enhanced security, and improved reliability.

l The Send Feedback form has been enhanced by the addition of two
new checkboxes. You can now choose to automatically attach the latest
errormessage and/or the log filewhen submitting feedback, making it
easier for us to diagnose and resolve issues quickly.
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Defect Fixes
l The Invert Model box is now automatically tickedwhen Correlogram is
selected in the Draw tab for continuity models, to avoid having to find and tick
it manually.

l Angles usingMicromine convention in the Rotation component are now
normalized between 0 and 360°.

l The Export action is now available for cross continuity models.
l Adjusting the Y-axis extent in the Log Probability plot with Gaussian
frequencies could previously break the display or make the plot unusable,
especially when editing multiple graphics. The component now remains
recoverable and behaves as expected when Y-axis limits are modified.

l Nugget and sill values of back-transformed variograms in Supervisor could
differ between the user interface and the saved XML project, leading to
inconsistencies when importing into Studio RM via the API. The values are
now correctly saved and reloaded, keeping the interface and project file
synchronised.

l Using the Fill block size table button in the KNA tool with certain
configurations could cause Supervisor to freeze and display graphical issues.
Changes have been made to improve stability, and this scenario should now
behave correctly.

l In some graphics, clicking the floating statistics table twicewithout moving
the mouse could cause ghost mouse pointer to remain permanently on the
screen. No ghost lines appear anymore after interacting with the table.

l The splash screen previously appeared distorted or cropped when launching
the application on certain displays, especially with non-standard scaling (e.g.
125%) or in virtual environments. The splash screen now maintains correct
proportions based on the image size and is no longer resizable.

l Importing DM files containing non-ASCII characters, as Russian characters
for example, previously failed due to encoding issues. The import process
now uses UTF-8 for string columns, allowing Russian and other non-ASCII
characters to be imported correctly.

l Contact Analysis could disappear from the project tree after reopening a
saved project and navigating away from its view, making it unusable. Contact
Analysis components are now correctly preserved and displayed.

l TheMerge domain interface has been improved to allow the selection and
the toggling of several checkboxes at once.
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l When launching the application, the interface could previously appear
minimized or off-screen if the display configuration had been changed. The
software now checks the saved window layout, and if it is invalid for the
current screen setup, a default position and size is used to ensure the window
is visible and accessible.

l An error appeared when adding another component to aModel Validation
component associated withMultivariate Simulations.

l When importing a Datamine block model, if the file geometrywas updated
from the outside, it was not correctly reloaded. You needed to click on Get
dimensions in the Block Model tab before clicking on Reload data in the
Loader part to see the modifications. The file is now correctly updated.

l In the Continuity Models, when displaying the table of structures, some of
the components were still present after deselecting the table.

l When installing Supervisor, if you unchecked the analytics statistics (errors
and usage), nothing happened when launching the software.

l Themessage displayed when exporting multivariate simulations in a
Datamine block model is now consistent with the name of the button in the
interface.

l If you used Save as Default on a Contact Analysis component, then trying to
run Contact Analysis again failed.

l When selecting graphics to display them together (for example variograms)
plus Cross Validation and Histogramwith a Normal Score Transformation,
the application required an update for the cross-validation last items while it
should not.

l In the Correlation Matrix, when applying a transformation, the cross plots
didn't update and an error could happen when clicking Update: “Error: Index
was outside the bounds of the array. Error while drawing”. An image has
also been added in the empty area, to make it easier to understand that one or
more cells of the correlation matrix must be selected in order to display the
corresponding scatter plots.

l When using a right click on a component in the Data Tree, some options in
the menu have disappeared between the v8 and v9 versions. In particular, it
was not possible to Save children components as a Template, but also options
to select portions of the tree. All the options are now available again.

l When upgrading a project from V8, if the project did contain continuity
fans, the items have to be updated or an error would occur.
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Supervisor 9.1.1 Hot Fix Release
Notes (July 2025)

Defect Fixes
l A crash or an error could occurwhen closing a project.
l Several installer issues have been fixed:

l DmFile.dllwas not registered correctly,
l Too recent DLLs already present in the installation directory were not
overwritten.

l When using 2D data files, the reload of associated output block models
(KNA, LKNO, conditional simulations), in 2D too, failed because of their flat
dimension (dz=0).

l A first correction has been made in 9.1 to avoid the issue that prevented users
from scrolling to the bottom of the Project tree. Another correction is
provided with this version as the problem was persistent.

l Since the 9.1 version, some table's scrollbars on property panels have
disappeared.

l The 2D rotation associated with a Datamine block modelwas not correctly
detected by the import (in the Rotate Data in 2D tab) if the two ROTAXIS2 and
ROTAXIS3 columns were not equal respectively to 2 and 1. The content of
these columns is now ignored.
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Supervisor 9.1 Release Notes
(May 2025)

New features & Improvements
l Installation & project upgrade:

l DirectX redistributables are now embedded in the installation. The
installation of DirectX 9 runtime is no more required.

l The default installation folder has been changed to C:\Program
Files\Datamine\Supervisor. This modification is applied for a new
installation. When upgrading from the previous version, the folder
remains C:\Program Files\Snowden\Snowden Supervisor v9.0.

l The splash screen visible when launching Supervisor 9.1, as well as the
application icon, have been updated according to the new Datamine
branding.

l A message is popped up when asking to save a 9.0 project in 9.1, as it
will make the project incompatible. To help you manage backward
compatibility, we recommend to save your project in a new file. This
creates an upgraded version of the original project, keeping a safety
copy of the previous version intact.

l Help: The email box in the user feedback form (reachable under the Help
menu) was previously mandatory. You can now optionally provide us with
contact details so that we can discuss your feedback and ideas with you
directly.

l Variography improvements:
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l As Leapfrog no longer has any restrictions on the number of allowable
structures for variogram models, the 2-structure restriction has been
removed from the export functionality when using the Leapfrog
compatibilitymode (*.lfv). The restriction is still present when exporting
in a *.xml file but it is not limited anymore to the spheroidal structure
only.

l The font size of the variogram model structures displayed next to the
different draggers can now be changed in the Draw tab.

Supervisor 9.1 Release Notes (May 2025) 18



l UX improvements:
l A scroll bar has been added in the Data Loader property panel.

l When using the boxplots, if you wanted to select only few items, you
had to untick all the others. This could be painful if you had lots of items
in the list. An 'All' checkbox has been added to the boxplot selection
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select/unselect all checkboxes at once.

l Rotations:
l A new Rotate Data in 2D tab is available in the property panel of the
Data Loader to deal with 2D rotation in Datamine block models. When
importing rotated Datamine block models, Supervisor imports the XC,
YC, ZC columns which are local rotated world coordinates. By
consequence, block model data cannot be compared to data located in
real world, like drillhole data for example and then apply a model
validation or KNA.
Clicking on the grid loader, angle and X/Y/Z translation fields show you if
the original file was rotated or not. They specify which transformations
should be applied to convert any data in the real coordinate system into
the local coordinate system.
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When reaching the properties of your drillhole data, by selecting your
block model in the Get transformation settings by selecting a data
loader field, you will automatically define the angle and the translation
along X, Y and Z to apply to your drillholes to be in the same local
coordinates as your block model.
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l In the Continuity Models, Datamine compatibility output has been
modified to be the same as Leapfrog. You have now an additional text
with Dip, Dip Direction, Pitch.

l Other: An error message has been added if you try to import .dmx files. This
new Datamine format is not yet supported but it will be available in the 9.2
version.
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Defect Fixes
l In the GT Curve, when unticking the Auto-title and modifying the title in the
properties panel, the axis label was correctly set but the associated legend
remained unchanged.

l In the HexBin plot, the line of regression and the first bisector line were
obscured by the hex elements when applied on the Log10 transformation.
Both lines are now displayed as foreground.
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l The Load Summary did not report the warnings/errors anymore. The area,
below the load table, was empty.

l The copy-paste between projects, broken in version 9, has been corrected.
l Contextual Help (F1) in version 9 did not open the correct page like it did in
version 8.15. Also the documentation file as well as release notes PDF
document were outdated in the installation.

l In the Correlation Matrix :
l Correlation coefficients displayed were wrong when applying a filter on
the samples. This could lead to values greater than 1 or smaller than -1.

Supervisor 9.1 Release Notes (May 2025) 24



l Changing the number of decimals to add more precision did not work
properly. The displayed number of decimals was correct, but the extra
decimals displayed 0 instead of the right value. Trigger an update of the
component solved the issue.

l In the Vario/Search tab of the Conditional Simulation properties,
l when dealing with lots of domains, the list could overlay the bottom of
the interface and some parameters. A scroll bar has been added to
avoid this problem.
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l Improved error message for missing simulation domains: If you select
a domain to simulate that isn't present in the output node grid or point
set, you will no longer encounter the generic “Index was outside the
bounds of the array” error. Instead, you'll see a clear message explaining
that the chosen domain could not be found in the output data.

l An error occurred when updating a V8 project with a detached data source.
l In the KNA, the block sizes defined using the Librarywere not taken into
account correctly.

l Multiple Grade Tonnage Curves, built from Block Models, can now be
overlaid using the Overlay option. Only the colours of the first selected item
are kept. The others are randomly redefined.

l An error occurred when importing a Vulcan Bmf file because of a missing
library.

l The SQL Data Loader did not work. You could enter the server name, but all
the other fields remained disabled.

l Several bugs linked to theWeight column have been corrected:
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l The block data loader stored default weighting entries, which caused an
error when the weight column was unavailable during reload.

l When importing sub-blocks contained in a Datamine file, a weight
column XINC*YINC*ZINC is now created by default and is applied to all
Assay columns.
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Supervisor 9.0.4 Hot Fix
Release Notes (October 2024)

Improvements
We’ve released a patch update for the .NET dependency integrated within
Supervisor. This update includes key performance improvements, security
patches, and critical bug fixes to enhance the stability and reliability of Supervisor.

Defect Fixes
l An issue has been fixed that prevented users from scrolling to the bottom of
the Project Tree.

l An issue has been fixed that caused variogram fans to sometimes be blank.

Important: You will need to reprocess any variograms created in
Supervisor 9.0.3 for this fix to be applied. To do this, open the affected
variogram and uncheck the Analyse checkbox in the Update tab of the
Property Panel, then re-check the Analyse checkbox and click the
Update button. This will cause the variogram to reprocess without making
any changes to your data. The reprocessed variogram should display the
normal contours.

l Multivariate Simulation decorrelation techniques now produce appropriate
scatter plot results

l Process cannot access file - error during conditional simulation
l An issue has been fixed that prevented the default histogram, probability plot,
and mean and variance plot from displaying beneath newly loaded assays and
domains.

Important: To correct this issue, you may need to reset the Library Tab of
the Component Options by clicking the Reset Layout button in the View
tab of the Ribbon Menu, then closing and reopening Supervisor. After
reopening Supervisor, the Library Tabmay need to be docked to the
Component Optionswindow.

l An issue has been fixed that prevented the default histogram, probability plot,
and mean and variance plot from displaying beneath newly loaded assays and
domains.
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l An issue has been fixed that prevented the Colour Key Library from loading in
new projects.

l The Multivariate Simulation component no longer produces an error when the
compositional transformation is used with a filler.

l An issue has been fixed where loading a project with a probability cutoff
component as part of a multivariate simulation would cause an error.
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Supervisor 9.0.3 Release Notes
(April 2024)
Supervisor Version 9 brings a long-deserved and significant technology upgrade to
the base platform that will allow us to continue to support and develop Supervisor
well into the future. While there are some changes to the overall look, Version 9
remains an evolution of the previous version with no reduced functionality or
changes to the core workflow. Ultimately, while we have modernised Supervisor, it
is not a new product and therefore is accessible by anyone with a current active
maintained license, subscription or rental.

Aside from the modernised user interface, users can enjoy the convenience of the
new ribbon menu and utilise greater customisation new dockable windows,
alongside a number of small quality of life changes. We are looking forward to your
feedback which can now be provided directly from within Supervisor itself with the
new ‘Send Feedback’ form under the Help menu. Through this form, you can
optionally provide us with contact details so that we can discuss your feedback and
ideas with you directly.

We hope that you enjoy the new Supervisor experience and look forward to
continuously improving our solutions into the future.
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Upgrading a Version 8 project
Upgrading your Supervisor projects from version 8 to version 9 is a straightforward
process. Launch the Supervisor 9 application and select the 'Upgrade V8 Project'
option from the Openmenu. Select the version 8 project you wish to upgrade, and
the application will create a duplicate of this project in version 9 format.

Please be patient as the creation process may take some time. Once the new
project is created, it will need to be updated for the results to be regenerated. It’s
important to note that once a project is upgraded to version 9, it cannot be reverted
back to version 8. Make sure you are ready to upgrade before proceeding.
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Updating the License Manager
To ensure there is no disruption to the ongoing experience using Supervisor, a
change has been rolled out to all existing license holders which converts current
Version 8 licenses to a bundled solution. Each bundle contains two licenses, one
that supports version 8 installations and one that will support all versions from 9
onwards.

The Version 9 installer comes bundled with version 6.2 of the Datamine License
Manager, which should ensure that it correctly detects the new license types and
structure. For any issues, please reach out to Datamine support for further
assistance and troubleshooting.
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Changelog
l Improved the error message associated with trying to add a component to the
Process Tree when no data is loaded.

l Removed the button link to the online LKNO video from the Property Panel.
l Fixed the resolution of vertical text to be easier to read.
l Fixed an issue that prevented interaction with the floating stats table in new
components.

l Corrected the outputs for Leapfrog which could be incorrect in some
situations.

l Reduced the number of decimal points for the Leapfrog conversion to
enhance readability.

l The UI has been replaced with a new platform and all components have been
updated to function as in version 8.

l The Histogram property panel has been redesigned.
l A Ribbon menu has been added which has all the previous functionality of the
old menus and vertical toolbar.

l An error capturing tool has been added, which can automatically and
anonymously report software errors to the Supervisor team for early
correction.

l Updated the .NET platform to version 6 and updated every component to be
compatible with this version.

l Updated Supervisor branding with latest logos and colour schemes.
l The about popup is more informative.
l Added a newWelcome page to the Data Tree root node.
l Updated several aspects of the Tree and Windows to allow greater user
customisation.

l Anonymous usage data may now be optionally provided to the Supervisor
team to help identify high-use components for improvements.

l Several default colour schemes have been updated.
l Updated coloured text in the Data Loader data tables from blue to teal.
l Modified the ‘ABORT UPDATING’ text on the main canvas to ‘UPDATING’.
l Several components in the Options tree have been renamed to be related to
their actual options.
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l Several Library components have had their names updated to relate to their
function.

l The version number has been added to the startup splash screen.
l Updated the default colours for the Histogram and several percentile colour
keys.

l Updated splash and install wizard images.
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Known Issues
Known issues are non-critical bugs that are currently being developed, but were
not able to be included in this release. All known issues will be resolved in the next
minor release.

l When selecting multiple components, the first selected component cannot be
deselected from the group.

l The line of regression on Hexbin plots is obscured by the hex elements.
l Editing multiple thresholds at a single time can cause an error.
l Changing the Y-axis label in the GT Curve component does not update the
legend label.

l The Load Summary does not provide detail for each encountered loading
error.

l The Cut-Off Value table in the Grade Tonnage Curve component for block
models does not create a scrollable element. Workaround: The list of cutoffs
can be created in an excel spreadsheet and pasted into the Cut-Off Values
table.
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Datamine enables efficient and sustainable
mining through the application of
world-leading technology and services.

Read the Docs
docs.dataminesoftware.com

Get in Touch
www.dataminesoftware.com/contact
www.dataminesoftware.com/support
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